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CHAPTER 2: KEYBOARD REVIEW

“Remembrance and reflection how allied! What thin partitions sense
from thought divide!”

– Alexander Pope

In the previous chapter, we outlined the reasons for using Windows®, but they all boil down

to one thing: Windows® is intended to make you, and the organization for which you work,

more productive. This review chapter is an important key to your productivity.

Unfortunately, most people who are self-taught do not

realize the productivity gains that Windows® promises. It

is essential that you get started on the right foot, for bad

habits are difficult to break.

You will soon see that Windows® allows users to do

tasks in many ways. For example, there are at least eight

ways to delete text. The novice may assume that one way

is as good as another. This is a fundamental error. How

you do it does matter!

THREE-PART KEYBOARD

The keyboard can be divided into three parts: the Alpha-

pad, the Cursor Pad, and the Number Pad.

Familiarize yourself with the location of the following

keys on the Alpha-pad, shown in Figure 42.

• “Escape”— —in the upper left.Esc

• Function keys, the “F-keys”—  . . .F1 F2 F3

—along the top.F12

• “Enter Key— —(sometimes large or oddly5Enter

shaped), sometimes called the “hard return” or

“return” key from the typewriter era.

• Also not the difference between the slash— , on/

the question mark key—and the backslash— ,\

above the Enter key.

• “Control key”— —on either end of the bottomCtrl

row.

• “Alt key”— —on either side of the space bar.Alt

• “Windows key”— —appears on keyboardsÿ

made after 1997, usually between  and .Ctrl Alt

The , , and  keys, like the  key, areCtrl Alt ÿ Shift

located on both sides of the Alpha-pad.

ESCAPE

Press  to eliminate unwanted dialogs. This is equi-Esc

valent to clicking  in a dialog.Cancel

HARD RETURN

Within a word processor, entering a so-called “hard re-

turn,” that is, pressing , is analogous to hitting the5Enter

return lever on a typewriter. This does not merely go down

a line, it creates a new paragraph.
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Pressing  within a dialog is equivalent to using5Enter

your mouse to click the default button, which is usually .OK

BACKSPACE

Pressing  (located above ) deletes theBackspace 5Enter

character to the left of the insertion point.

CURSOR PAD

Next, examine the Cursor Pad, between the Alpha-pad and

the Number Pad.

Typically the Cursor Pad looks like this:

Insert Home
Page

Up

De lete End
Page

Dow

á

ß â à

MANEUVER AROUND THE DOCUMENT

Use the keys on the Cursor Pad to reposition the cursor:

•  = go to beginning of the lineHome

•  = go to end of the lineEnd

•  or  = go up or down one screen
Page
Up

Page
Down

•  or  = go left or right one characterß à

•  or  = go up or down one lineá â

DELETE

Pressing  deletes the character to the right of theDelete

insertion point.  Be sure this distinction is clear:

•  deletes the character to the left.Backspace

•  deletes the character to the right.Delete

INSERT

Pressing  toggles between typeover mode and in-Insert

sert mode. (“Toggle” means you press it once to turn it on

and press it again to turn it off.) Typeover mode does what

it says: it “types over” existing text. Insert mode inserts

text at the insertion point, pushing existing text to the

right. Some modern applications, notably Microsoft®

Word, allow the user to disable Typeover mode.

THE MAGIC  KEYCtrl

The  key can be used with various Cursor Pad  keysCtrl

to enhance their power. Here are some examples:

Remember:  sends the insertion point to the begin-Home

ning of the line;

(  sends the insertion po int to theCtrl Home

beginning of the document.

� � �

Remember:  sends the insertion po int to the end ofEnd

the line;

(  sends the insertion point to the end ofCtrl End

the document.

� � �

Reminder:  deletes the character to the right of theDelete

insertion point;

(  deletes the word  to the right of theCtrl Delete

insertion point.

� � �

Reminder:  deletes the character to the left ofBackspace

the insertion po int;

(  deletes the word  to the left of theCtrl Backspace

insertion point.

� � �

Reminder:  or  moves the insertion point left orß à

right, character-by-character;

(  or  moves the insertion pointCtrl ß Ctrl à

left or right word-by-word .

� � �

Remember:  or  moves insertion point up orá â

down, line-by-line;
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(  or  moves insertion point upCtrl á Ctrl â

or down, paragraph-by-paragraph.

� � �

Remember:  or  goes up or down one screen;
Page
Up

Page
Down

(  or  goes up or down oneCtrl
Page
Up Ctrl

Page
Down

page.

� � �

Remember: Pressing  creates a new line, or, more5Enter

specifically, a new paragraph;

(  creates a new page.Ctrl 5Enter

Do you see the pattern? The  key enhances the effectCtrl

of the cursor control keys.

NUMBER PAD

Finally, note the Number Pad, to the right of the Cursor

Pad. The Number Pad has a dual function; press  to
Num
Lock

toggle between numbers and cursor movements. This is a

hold-over from old-style, 84-key keyboards that didn’t

have a Cursor Pad.

SELECT, THEN APPLY

The general rule of formatting text in Windows® is

“Select, then apply.” For example, to italicize an existing

word, you must select the word and then apply the italics.

There are three primary ways to select text:

• Click-and-drag;

• Double-click a word; or,

•  + a navigation key, such as , , ,Shift ß à á

, , , , , andâ Ctrl Home Ctrl End End Home

so on.

For example, if you select text and apply a new font, the

selected text, and only the selected text, will change to the

new font.

Attributes aren’t the only thing you can apply. If you

select text and press , the selected text will beDelete

deleted. If you select text and apply a keystroke, such as

, or a letter, such as , the selected text will be5Enter M

replaced with a hard return, or the  letter “M.”

BOLD , ITALIC , &  UNDERLINE

We have seen that  key is in conjunction with variousCtrl

keys on the Cursor Pad to enhance their effect. If you

know what a Cursor Pad key does, it’s easy to figure out

what happens when you press  along with it.Ctrl

When it is used in conjunction with the Alpha-pad,

 creates a shortcut key combination. You simply haveCtrl

to memorize a handful of these. For example, in many

applications, you can select text and apply these attributes

without moving your hands from the keyboard:

• = Bold toggle;Ctrl B

• = Italic toggle; and,Ctrl  I

• = Underline toggle.Ctrl U

This works fine for existing text,  but it also works “on the

fly.” For example, to underline a word as you type, press

 to toggle underline on, type the text to be under-Ctrl U

lined, and press  again to  toggle it off.Ctrl U

UNDO

Press  to undo the very last procedure you did inCtrl Z

an application. It may help you to remember that Z is the

very last letter in the alphabet and that  undoesCtrl Z

the very last thing you did.

Pressing  is equivalent to clicking the UndoCtrl Z

icon, , in more sophisticated Windows® applications,

such as Microsoft® Office.

The number of changes that you can undo varies by

program. Some programs, such as Notepad, can undo only

one operation; others, such as Microsoft® Word 2000 or

XP, can undo up to 99  changes. You cannot undo a file

operation, such as printing or saving a document, nor can

you undo changes to a program’s options.
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Figure 49

Figure 46

CUT, COPY & PASTE

Probably the single most important feature of W indows®

is its ease of cutting, copying, and pasting text, graphics,

and other objects.

When you use either the Cut or Copy command, the

item that was selected is placed in Windows® Clipboard.

Once something is placed in Clipboard, it will stay there

until something else is subsequently cut or copied, or the

PC is rebooted.

The Paste  command inserts the contents of Clipboard at

the insertion point. Paste does not affect the contents of

Clipboard. Once something is copied to Clipboard, it can

be pasted again and again.

Examine the following Edit menu. Note the following

shortcut keys, listed to the right of each command:

•  = UndoCtrl Z

•  = CutCtrl X

•  = CopyCtrl C

•  = PasteCtrl V

File Edit View Insert

 Undo... Ctrl+Z

 Cut Ctrl+X

 Copy Ctrl+C

 Paste Ctrl+V

 Paste Special...

...and so on

Why is Paste ? W hy not ? The answerCtrl V Ctrl P

is found on the lower left of your keyboard:

Z X C V

Knowing these four shortcut keys is essential to your prog-

ress in Windows®.

ACCESS KEYS

On page 5 , we introduced selecting items from the pull-

down menus with the mouse. We can also make menu

choices with the keyboard.

The  key is sometimes called the “access key,”Alt

because we use it to access  the pull-down menus. As you

can see in Figure 46, each menu item has one underlined

letter. (The access letter may not appear until you press

.) Press  to access the File menu,  toAlt Alt F Alt E

pull down the Edit menu, and so on.

To select a menu item from a pull-down menu, simply type

its access letter. This means that to paste the contents of

Clipboard, press , and then .Alt E P

ACCESS KEYS &  XP

Inexplicably, Access keys are hidden by default in Win-

dows® XP until you press . To turn off this behavior:Alt

Step 1: Click  and open Control Panel, Dis-

play.

Step 2: Click .

Step 3: Deselect the “Hide underlined letters for keyboard

navigation until I press the Alt key” check box.
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Figure 52

Step 4: Click  twice to apply your change and

close the dialogs.

Step 5: Close the Display dialog.

WINDOWS® KEY

Newer keyboards have an additional key—between Alt

and —called the “Windows® key.” Pressing Ctrl ÿ

alone opens the Start menu, as if you had clicked

 or . The Windows® key providesÿ  Start

several shortcuts:

• Press  to get Windows® Help.ÿ F1

• Press  to open Windows Explorer.ÿ E

• Press  to open the Find Files utility.ÿ F

• Press  to open the Run box.ÿ R

SUMMARY

Now that we’ve done all this, what’s the point? In this

chapter, we looked at a lot of keystrokes en route to

learning three important points:

The Windows® interface is systematic. Once we learn

the system, there is no need to memorize keystrokes. This

is essential in learning all computer applications—if you

are memorizing keystrokes, you have missed the point.

Instead, learn the system behind it. You simply don’t have

the time or the ability to memorize keystrokes all day.

In this chapter, we learned that, once you know what

the cursor keys are, you can enhance them with the Ctrl

key. Selecting with the keyboard is just a matter of

applying  to what you have learned.Shift

How you do things matters. For almost all routine

tasks in almost all applications, you should learn two ways

of doing things: one, when your hand is on the mouse, and

another, when you hands are on the keyboard. Almost

always, using the keyboard method is:

• more accurate;

• faster;

• universal (i.e., the keystrokes work in all or most

applications); and,

• safer; it prevents carpal tunnel syndrome and other

physical problems associated with mouse use.

Yes, you have to adapt to the computer. I have good

news and bad news. The bad news is that you have to

memorize a few things and practice them until they are

second nature.  I know, I know. Windows® was supposed

to alleviate all that memorization. The good news is that

you’re done. That’s all there  is. Now our focus turns to

how to make the computer adapt to you!

OFFICE 2000 CLIPBOARD

Microsoft® Office 2000 products, such as Word or Excel,

provide a new wrinkle on the usual cut, copy and paste

options. When you cut or copy the first item, no thing is

unusual. When you cut or copy a second time, a new menu

appears, showing two items. Each subsequent time that

you cut or copy an item, another icon will appear in the

menu, up to a maximum of twelve, as shown in Figure 52.

If you attempt to add more than twelve items, the first item

copied will be removed, and the new one will be added to

the end.

PASTE FROM THE OFFICE CLIPBOARD

If you press , you will paste the last item copied,Ctrl V

just as you would expect. To paste any other item from the

Office Clipboard , simply click the item in the Clipboard

menu in Figure 52. (Note that each item’s contents will

appear in a yellow pop-up as you pass your mouse over it.)

CLEAR THE OFFICE CLIPBOARD

To clear the contents of the Office 2000 Clipboard, click

the Clear Clipboard  icon, , on the menu shown in

Figure 52.

TASK PANELS

The most obvious addition to Office XP applications is the

Task Panel along the right of the screen. The Task Panel
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Figure 54

Figure 55

Recent
documents

Expand list

Figure 56

offers you quick access to the most common features that

you need at the moment. For example, when you open

Word, the New Document Task Panel appears on the

right, as shown in Figure 54

To explore your options, expand the New Document drop-

down list:

CLOSE THE TASK PANEL

The Task Panel is valuable, but it does take up valuable

screen real estate. If you prefer to turn it off:

• At the bottom of the Task Panel, deselect Show at

startup check box, shown in Figure 56

CLIPBOARD TASK PANEL

When you cut or copy an item, it is stored in the

Windows® Clipboard. Traditional the Clipboard held one

item at a time. Office 2000 allowed you to store up  to

twelve items in Clipboard, and XP extends that number to

24. To demonstrate how this works:

Step 1: If the Task Panel is present, either:

• 7  press  (that is, hold down pressCtrl C C

 and press  twice; or,Ctrl C

• 8  click the drop-down list and select Clipboard.

If the Task Panel is not present, either:

• 7  press ; (again, hold down pressCtrl C C

 and press  twice; or,Ctrl C

• 8  from the pull-down menu, select Edit, Office

Clipboard.

Step 2: Select some text and  press  to copy orCtrl C

 to cut.Ctrl C

• In either case, the selection will appear on the Clip-

board Task Panel.

Step 3: Copy additional items, from other applications.

• In each case, the  selection is added to the Clipboard

Task Panel, as shown in Figure 57.
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Figure 57

Figure 58

Figure 59

Figure 61

PASTE AN ITEM

Step 4: To paste an item into your document, place the

curser where you want it to appear, and either:

• double-c lick

the item in

t h e  T a s k

Panel;

• click the 6

to the right of

the item and select Paste from the pop-

up menu, as seen in Figure 58; or,

• right-click the item and select Paste from the pop-up

menu.

You can also press  to paste. This will simplyCtrl V

paste the very last thing that you cut or copied, as it always

has.

PASTE OPTIONS

When you paste in

Office XP, a small Paste

options icon, , will

appear, below and to its

right, as shown in Figure

59. As you pass your

mouse over this icon, a  drop-down arrow,

6 , will appear by its side. If you click the arrow, its

options will expand, as shown in Figure 61.

By selecting the appropriate option button, you can paste

the text so that it maintains its previous formatting,

matches the destination formatting, or pastes raw, unfor-

matted  text only.

NOTES
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Figure 66

LAB 1: LOOK LIKE EVERYONE ELSE

If you are a new user, it can be pretty terrifying to realize suddenly that your screen doesn’t

look anything like those of the people sitting on either side of you, or like it does on your

home PC. This lab will make sure that you can make Word look the way you want it.

THE PROBLEM

Word is immensely adaptable to your needs and pref-

erences. When you become more accomplished with the

program, you will find that a great blessing. Unfortunately,

as a beginner, you may find  it perplexing, to say the least.

FIVE AREAS

There are five features that greatly effect how Word

appears:

• Show/Hide formatting;

• toolbar appearance and location;

• document view;

• adaptive menus; and,

• Task Panel (XP).

How you use any of these features is completely irrelevant.

None have any effect on how the program works or how

the document appears when it is printed. The issue here is

appearance, only. It is enough to know, at this point, how

to turn these features on and off, so your screen will look

like your neighbor’s, like your instructor’s, or like the

examples in this book.

SHOW/HIDE FORMATTING

When you click the Show/Hide icon, , found on the

Standard toolbar, it displays non-printing characters to

your text. These characters show where various codes are:

• a space is indicated with a •

• a tab is indicated with a à

• a carriage return is indicated with a ¶

Later, you will see how these and other marks are used.

Try this:

Step 1: Type a sentence on the screen and press .5Enter

Step 2: Either:

• 8  click  on the Standard toolbar, or,

• 7  press Ctrl Shift *

Step 3: Click the  Show/Hide icon, , again.

• Note that each time you click , it toggles the

formatting characters. Click it once, turn them on;

click again, turn them off.

It is irrelevant whether you show or hide these marks; what

is important at this point is that you know how to turn

them on and off.

TOOLBAR APPEARANCE

When you start Word, there should be two toolbars,

resembling those in Figure 66:

• Standard toolbar; and,

• Formatting toolbar.

GETTING THE TOOLBARS

You may see ten toolbars, or you may see none at all. To

select only the Standard and Formatting toolbars:

Step 1: From the pull-down menu, select View, Toolbars.

Step 2: Make sure you have selected Standard and For-

matting, as shown in Figure 67.

• If there is no check mark  in front of either one, click

it to select it.

• If there is a checkmark  in front of anything else,

click it to deselect it.



PAGE 20 LAB 1: LOOK LIKE EVERYONE ELSE WAYNE THOMAS SPIES

Figure 68

Figure 67

Step 3: Repeat this process

until only the Standard and

Formatting toolbars appear.

DIFFERENT LINES

By default, Word 2000/XP places both toolbars on the

same line. To place them on separate lines, as shown in

Figure 66:

Step 1: From the pull-down menu, select View, Toolbars,

Customize.

Step 2: Deselect the “Standard and Formatting toolbars

share one row” check box shown in Figure 68.

Step 3: Click  to apply your changes andClose

close the dialog.

REPOSITION TOOLBARS

The Standard and Formatting toolbars may not appear

where you expect them. Word’s toolbars can be docked in

any one of five positions:

• left dock;

• right dock;

• top dock;

• bottom dock; and,

• floating.

To reposition a toolbar, click it anywhere—other than a

button—and drag it to another of these positions. It may be

easiest to click-and-drag the positioning handle—the two

vertical bars at the left of each toolbar seen here:

or, in Windows® XP:

Positioning handles
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Figure 72

Figure 73

REPOSITION THE MENU

Word also allows you to reposition the pull-down menu

bar, just as you would a toolbar, by clicking-and-dragging

the menu’s Positioning handle.

LOCK DOWN

As you can imagine, the ability to move menus and

toolbars around by simply clicking and dragging can mean

chaos in public facilities like computer labs, shared

machines, and so on. To solve this problem, some XP

applications give you the ability to lock their position. For

example, if you have Windows XP, either:

• 7   press ; or,ÿ E

• 8  from the Taskbar, click  and select

All Programs, Accessories, Windows Explorer.

This opens a program called Windows® Explorer, which

we will work with in Chapter 3. 

By default, Explorer’s taskbars and pull-down menus

are locked. There are no repositioning handles, and you

cannot reposition them. To turn this on, right-click the

toolbar area and select Lock the T oolbars on the drop-

down menu. Now you can move the toolbars or menu.

To relock these toolbars:

Step 1: Right-click the toolbar area, and select Lock the

Toolbars from the pop-up menu, as shown in Figure 72.

VIEWS

From the pull-down menu, select View. As you can see in

Figure 73, there are several ways of looking at your

document:

• Normal view;

• Web Layout view;

• Print Layout view; and,

• Outline view.

Of these, the two that you will use most often are the

Normal and P rint Layout views.

Print Layout view is truly WYSIWYG (What You See

Is What You Get); that is, if you were to print the docu-

ment, you would get exactly what appears on the screen—

headers, footnotes, columns, the whole nine yards. It even

gives you the illusion that there is a sheet of paper inside

your monitor, by displaying the margin area and the

“edge” of the paper. When you are in the Print Layout

view, your document window will look like Figure 74.

XP positioning handles
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In Print Layout, the “edge” of
the paper can be seen.

Figure 74

Figure 75

Now, let’s compare this to the Normal view. The same

document seen in Figure 74 will look like Figure 75 if you

switch to the Normal view:

Notice how the text fills the window. The Normal view

hides the margins and the “edge of the paper. Also , note

that a horizontal line marks the end of the document.

Unlike the Print Layout view, Normal view is not quite

WYSIWYG. It recognizes that the user doesn’t need to

see many things exactly as they appear—indeed some

things may be distracting. Therefore, Normal view does

not show some things, such as:

• headers and footers;

• footnotes and endnotes; and,

• columns.

To return to the Print Layout view, either:

• 7  press ; or,Ctrl Alt P

• 8  from the pull-down menu, select View, Print

Layout.

ADAPTIVE MENUS

And speaking of the pull-down menus, Word 2000/XP,

like all Office 2000/XP applications, uses adaptive menus.

This feature remembers which commands you use most

often. When you click an item from the pull-down menu,

the adaptive menu expands, displaying only those items

that you use most often.

The options that you rarely use stay hidden. Hidden

commands are still available. To display them, click the

unfold button, , at the bottom of the

menu. (After about five seconds, the menu automatically

unfolds, whether you make a choice or not.)

TURN OFF ADAPTIVE MENUS

Adaptive menus can be a boon to productivity, but they

can hinder your learning: “Out of sight, out of mind!” I

recommend that you turn off adaptive menus while you are

learning Word. To turn off adaptive menus:

Step 1: From the pull-down menu, select Tools, Cus-

tomize.

Step 2: On the Options tab, deselect the “Menus show

recently used commands first” check box.

Step 3: Click  to apply your change and closeClose

the dialog.

This change will affect all Office 2000/XP applications

simultaneously.

RESET ADAPTIVE MENUS

To reset the menus to their defaults:

Step 1: From the pull-down menu, select View, Toolbars,

Customize.

Step 2: On the Options tab, click , asReset my usage data

shown in Figure 77.

A horizontal line marks the
end of the document.

In Normal view, text
fills the screen.

In Print Layout view, the
margin area can be seen.
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Figure 77

Figure 79

Figure 78

Step 3: Click  to apply your change and closeClose

the dialog.

This will make Word forget how you have used the menu

and restore  the menus, as they came from the factory.

TASK PANEL

Introduced in Word XP, the Task Panel sits along the right

of the window, provid ing easy access to commonly used

features. As you know, in Windows®, when you right-click

an item, a context-sensitive pop-up menu will appear that

give you various options. Using the Task Panel is some-

thing like having a context-sensitive pop-up menu open all

the time, giving you instant access to the most features you

are most likely to use at any given moment.

For example, when you launch Word, the Task Panel

seen in Figure 78 will appear. It offers you a choice of the

things you are most likely to do, such as opening a recent

document, creating a new Word document, a new e-Mail

message, or a new Web page, or creating a Word

document based on another template.

The Task panel is helpful, but its constant appearance

limits the amount of the document you can see. Since all

of its options are already available by clicking File from

the pull-down menu, you can increase the amount of real

estate available to your document by turning it off. Later,

when you need it, it will automatically appear.

To turn off the Task panel so that it doesn’t open

automatically when you launch Word:

Step 1: From the pull-down menu, select Tools, Options.

Step 2: On the View tab, deselect the Startup Task Pane

check box:

Step 3: Click .OK

Blank document
= Normal.dot

Recently used
documents
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Once you are comfortable with Word, you can always turn

this back on, if you wish, but, until then, it’s a good idea to

leave it off.

CONCLUSION

Again, it is irrelevant whether you use these features or

not. At this point it is enough to know how to turn them on

and off, so you can look just like everybody else, which,

after all, is our goal in America.

I recommend that you use the following settings

exclusively until you feel completely comfortable with

Word:

• do not show formatting marks;

• always show the Standard  and Formatting toolbars,

docked at the top, in separate lines;

• turn off the adaptive menus; and,

• turn off the Task Panel at start-up.

Use either the Normal or Print Layout view, as you prefer.

NOTES
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